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10. Γραφικά 3Δ & Σχεδιοκίνηση με 3ds Max & Blender 

 
Σύνοψη 
Στο παρόν κεφάλαιο γίνεται μια εισαγωγή στο λογισμικό 3ds Max της Autodesk και στο εργαλείο ανοιχτού κώ-
δικα Blender. Μέσα από βήμα-προς-βήμα ασκήσεις παρουσιάζουμε τον τρόπο λειτουργίας των εργαλείων και 
εξηγούμε κάποιες από τις βασικές τους δυνατότητες. 

Προαπαιτούμενη γνώση 
Στο κεφάλαιο 4 έγινε ανάλυση των θεωρητικών θεμάτων, που σχετίζονται με τα γραφικά 3Δ και τη σχεδιοκίνη-
ση και συνεπώς πρέπει να μελετηθεί πριν το τρέχον κεφάλαιο.  

 

10.1. 3ds Max 
 
Το 3ds Max (http://www.autodesk.com/products/3ds-max) είναι ένα εμπορικό επαγγελματικό εργαλείο της 
Autodesk για γραφικά 3Δ και animations. Οι τελευταίες εκδόσεις διατίθενται μόνο για λειτουργικά συστήμα-
τα 64-bit. Η Autodesk διαθέτει και δωρεάν εκδόσεις των λογισμικών της για φοιτητές και εκπαιδευτές. Το 
εργαλείο έχει πάρα πολλές δυνατότητες και έχει χρησιμοποιηθεί και για τη δημιουργία ταινιών. Στην ιστοσε-
λίδα http://knowledge.autodesk.com/support/3ds-max υπάρχουν οδηγοί χρήσης του εργαλείου και γενικά στο 
διαδίκτυο υπάρχουν πάρα πολλοί οδηγοί χρήσης, κυρίως, σε μορφή βίντεο. 

 

10.1.1. Γνωριμία με το περιβάλλον εργασίας του 3ds Max 
 
Στην Εικόνα 10.1 εμφανίζεται το περιβάλλον εργασίας του εργαλείου. Η βασική οθόνη χωρίζεται σε 4 τμήμα-
τα (σημείο 1) που ονομάζονται viewports και αποτελούν διαφορετικές όψεις του ίδιου αντικειμένου. Στα ση-
μεία 2, 3, και 4 υπάρχουν διάφορες ρυθμίσεις και επιλογές σχετικά με τα αντικείμενα σχεδίασης που έχουν 
τοποθετηθεί στη σκηνή.  

 

 
 
Εικόνα 10.1 Το περιβάλλον εργασίας του 3ds Max. 
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Στην προεπιλεγμένη ρύθμιση (default setting) τα τρία viewports δείχνουν από τρεις διαφορετικές δι-
διάστατες οπτικές, κάθετες μεταξύ τους (κάτοψη, πρόσοψη και πλάγια όψη), το σκελετό (wireframe) των 
σχημάτων που έχουν δημιουργηθεί. Το τέταρτο παράθυρο κάτω δεξιά δείχνει τα αντικείμενα κανονικά, δηλα-
δή από μια ενδιάμεση γωνία, με προοπτική (perspective). Σε κάθε παράθυρο υπάρχει το σύμβολο [+]. Με 
κλικ στο + εμφανίζονται οι επιλογές «Maximize viewport» για μεγέθυνση του παραθύρου ή η επιλογή 
«Restore viewport» για επαναφορά του παραθύρου.  

 

10.1.2. Δημιουργία και επεξεργασία βασικών αντικειμένων 
 
Τα βασικά (primitive) 3D σχήματα, που φαίνονται στην Εικόνα 10.2, βρίσκονται στο σημείο 3 της Εικόνας 
10.1 πιο πάνω. Τα σχήματα αυτά είναι διαθέσιμα και μέσω του μενού  «Create > Standard primitives». 
Στην Εικόνα 10.3 έχουμε σχεδιάσει διαφορετικά αντικείμενα. Τα σχήματα σχεδιάζονται με κλικ πάνω στη 
σκηνή και μετακίνηση του ποντικιού, διατηρώντας το αριστερό κουμπί του ποντικιού πατημένο.  

 

 
 
Εικόνα 10.2 Βασικά σχήματα του 3ds Max. 

 

 
 
Εικόνα 10.3 Βασικά τρισδιάστατα αντικείμενα. 

 
Στην Εικόνα 10.4 βλέπουμε τα σχήματα από άλλη οπτική γωνία. Αυτό επιτυγχάνεται με χρήση του 

λευκού εικονιδίου, που βρίσκεται στη δεξιά πλευρά κάθε παραθύρου σχεδίασης. Δηλαδή, αν κάνουμε κλικ 
στο εικονίδιο και αρχίσουμε να το περιστρέφουμε, έχοντας πιεσμένο το αριστερό κουμπί του ποντικιού, τότε 
μπορούμε να περιστρέψουμε τη σκηνή. 

Τα αντικείμενα επιλέγονται κάνοντας κλικ πάνω τους. Με δεξί κλικ πάνω σε κάποιο αντικείμενο, εμ-
φανίζονται αρκετές επιλογές, π.χ.: 

 Scale: μεταβολή μεγέθους. 
 Rotate: περιστροφή. 
 Select: επιλογή. 
 Move: μετακίνηση. 
 Curve editor: επεξεργασία των καμπυλών των σχημάτων. 
 Convert to…: επιλογές για μετατροπή σε πολύγωνα και περαιτέρω επεξεργασία. 
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Στην Εικόνα 10.5 εμφανίζονται δύο αντικείμενα. Ξεκινήσαμε με δύο αντικείμενα τύπου Sphere και 
Torus και με χρήση της επιλογής δεξί κλικ και «Scale» κάναμε μεταβολή του μεγέθους κάθε σχήματος. Η 
τοποθέτηση του σχήματος που μοιάζει με αυγό έγινε από το viewport «Top», καθώς είναι πιο εύκολα κατα-
νοητή η λειτουργία που πρέπει να γίνει. 

Η αλλαγή του χρώματος γίνεται με επιλογή του χρώματος, στη δεξιά πλευρά του 3ds Max, κάτω από 
την επιλογή του σχήματος. 

 

 
 
Εικόνα 10.4 Περιστροφή της τρισδιάστατης σκηνής. 

 

 
 
Εικόνα 10.5 Αντικείμενα στα οποία έχει γίνει μεταβολή σχήματος. 

 
Στην Εικόνα 10.6 εμφανίζονται οι κατηγορίες αντικειμένων 3D που υπάρχουν στο 3ds Max. Για πα-

ράδειγμα, το σχήμα της Εικόνας 107 δημιουργήθηκε με χρήση αντικειμένων από την κατηγορία Stairs και 
Doors. 

 

 
 
Εικόνα 10.6 Κατηγορίες δημιουργίας αντικειμένων 3D. 

 

10.1.3. Επεξεργασία μορφής σχήματος 
 
Στο σχήμα 10.8 εμφανίζονται δύο σχήματα, στα οποία εφαρμόστηκαν κάποιοι βασικοί μετασχηματισμοί. 

Χρησιμοποιήθηκε η επιλογή «Modify» . Στο αντικείμενο Torus έχουν εφαρμοστεί οι μετασχηματισμοί 
Radius 1: 37, Radius: 2, Twist: 2000, Segments: 25, Slides: 5. Στο αντικείμενο Sphere έχει αλλάξει η παράμε-
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τρος Hemisphere: 0,5. Οι παράμετροι καθορίζουν γενικά την εμφάνιση των αντικειμένων. Η παράμετρος 
twist, για παράδειγμα, καθορίζει τον αριθμό συστροφών του αντικειμένου. 

Κάτω από το εικονίδιο «Modify»  υπάρχει η αναδυόμενη λίστα «Modifier list». Εκεί παρατίθεται 
ένα σύνολο από τροποποιητές, που μας επιτρέπουν αλλαγές πάνω στα τρισδιάστατα αντικείμενα. 

 

 
 
Εικόνα 10.7 Απλό τρισδιάστατο σχήμα. 

 

 
 
Εικόνα 10.8 Σχήματα, στα οποία έχουν εφαρμοστεί απλές ρυθμίσεις. 

 
Ένας άλλος τρόπος επεξεργασίας της μορφής ενός σχήματος είναι με χρήση δεξί κλικ πάνω σε κά-

ποιο αντικείμενο και επιλογή «Convert to > Convert to Editable Mesh». Στην Εικόνα 10.9 σχεδιάσαμε μια 
σφαίρα, στην οποία εφαρμόσαμε την επιλογή αυτή. Η σφαίρα παίρνει τη δεύτερη μορφή της Εικόνας 10.9, 

όταν κάνουμε κλικ στο εικονίδιο  που αφορά τις κορυφές (vertex) του πλέγματος πολυγώνων 
(Mesh). Με κλικ και σύρσιμο κάποιων κορυφών μπορούμε να αλλάξουμε τη μορφή του αντικειμένου. 

 

 
 
Εικόνα 10.9 Αλλαγές σε ένα σχήμα με χρήση της επιλογής «Editable Mesh». 

 
Αν θέλουμε να κάνουμε Rendering της σκηνής, τότε επιλέγουμε το μενού «Rendering > Render». 

Μπορούμε να αποθηκεύσουμε τη σκηνή απευθείας ως εικόνα, με την επιλογή «Save image». 
 

10.1.4. Προσθήκη υφής 
 
Στο συγκεκριμένο παράδειγμα θα προσθέσουμε μια υφή ξύλου σε ένα αντικείμενο Box. Αρχικά σχεδιάζουμε 

το Box και έπειτα κάνουμε κλικ στο εικονίδιο . Εμφανίζεται το παράθυρο της Εικόνας 10.10. Στη συνέχεια 
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επιλέγουμε μία από τις σφαίρες που αντιπροσωπεύουν διαφορετικές υφές. Κάνουμε κλικ στο τετράγωνο εικο-
νίδιο μετά το Diffuse (σημείο 1 της Εικόνας 10.10) και επιλέγουμε «Bitmap» και OK. Εμφανίζεται το παρά-
θυρο επιλογής του αρχείου εικόνας της υφής και, όταν την επιλέξουμε, θα εμφανιστεί στη θέση ενός κύκλου. 

Στη συνέχεια μπορούμε να κάνουμε κλικ στο εικονίδιο «Assign Material to Selection» (σημείο 2 της 
Εικόνας 10.10). Τέλος, με κλικ στο εικονίδιο «Show Shaded Material to Viewport» (σημείο 3 της Εικόνας 
10.10) εμφανίζεται η υφή στο αντικείμενο (Εικόνα 10.11). Μπορούμε να φορτώσουμε και άλλες υφές στις 
άλλες σφαίρες και τελικά να εφαρμόζουμε διαφορετικές υφές στα αντικείμενα της σκηνής. 

 

 
 
Εικόνα 10.10 Material Editor. 

 

 
 

Εικόνα 10.11 Εφαρμογή υφής σε αντικείμενο. 

 

10.1.5. Απλό animation αντικειμένων 
 
Ένας απλός τρόπος κίνησης ενός αντικειμένου, π.χ. μιας σφαίρας, είναι με χρήση του κουμπιού «Auto Key», 
που υπάρχει στο κάτω μέρος του 3ds Max (Εικόνα 10.12). Αρχικά σχεδιάζουμε τη σφαίρα στο αρχικό σημείο, 
όπου θέλουμε να αρχίζει το animation, και φροντίζουμε το κουτάκι δίπλα από το Key filters να γράφει 1. Ου-
σιαστικά ορίζουμε το πρώτο σημαντικό καρέ (keyframe) της κίνησης.  

 

 
 

Εικόνα 10.12 Εικονίδια χρήσιμα για το animation με χρήση του Auto Key. 

 
Στη συνέχεια πρέπει να ορίσουμε τα υπόλοιπα keyframes της κίνησης. Μετακινούμε τη σφαίρα σε 

κάποια θέση και ορίζουμε σε ποιο καρέ (π.χ. στο 15) της κίνησης αντιστοιχεί αυτό το keyframe. Έπειτα ορί-
ζουμε κάποιο άλλο keyframe σε κάποιο άλλο καρέ (π.χ. στο 30) κ.ο.κ. Το τελικό keyframe ορίζεται στην τε-
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λική θέση, όπου πρέπει να μετακινηθεί η σφαίρα. Όταν ολοκληρώσουμε τη διαδικασία, απενεργοποιούμε το 
κουμπί «Auto Key». Κάνοντας κλικ στο εικονίδιο Play Animation , γίνεται αναπαραγωγή της κίνησης. 

Για να κάνουμε εξαγωγή του animation πρέπει να επιλέξουμε αρχικά το εικονίδιο «Render Setup» 
στο σημείο 1 της Εικόνας 10.13. Στο σημείο 2 της Εικόνας 10.13 μπορούμε να ορίσουμε πόσα frames (καρέ) 
της θέλουμε να εξάγουμε. 

Πιο κάτω στο ίδιο παράθυρο υπάρχει η ομάδα εργαλείων «Render Output», όπου πρέπει να επιλέ-
ξουμε το κουμπί «Files», για να ορίσουμε το όνομα αρχείου του animation. Πατώντας το «Save», μπορούμε 
να ορίσουμε και τον codec που θα χρησιμοποιηθεί στο βίντεο. Τέλος, με το κουμπί «Render» γίνεται εξαγω-
γή του βίντεο.  

 

 
 

Εικόνα 10.13 Επιλογές Render για την εξαγωγή του animation. 

 

10.2. Blender 
 

Το Blender (http://www.blender.org) είναι ελεύθερο λογισμικό γα τη σχεδίαση 3D γραφικών και animations. 
Αποτελεί μια από τις πιο δημοφιλείς εφαρμογές ανοικτού κώδικα στον κόσμο για σχεδίαση τρισδιάστατων 
γραφικών, που έχει χαρακτηριστικά συγκρίσιμα με τις εμπορικές εφαρμογές. Χρησιμοποιείται για μοντελο-
ποίηση, κινούμενα γραφικά και για δημιουργία αλληλεπιδραστικών 3D εφαρμογών, όπως τα βιντεοπαιχνίδια. 
Είναι διαθέσιμο σε όλα τα κύρια λειτουργικά συστήματα. 

 

10.2.1. Γνωριμία με το περιβάλλον εργασίας του Blender 
 
Κατά την εκκίνηση του Blender εμφανίζεται η οθόνη εκκίνησης (Εικόνα 10.14), η οποία δίνει γρήγορη και 
εύκολη πρόσβαση σε πρόσφατα ανοιγμένα αρχεία Blender. Εμφανίζεται και η έκδοση του Blender.  

Κάνοντας κλικ έξω από την οθόνη εκκίνησης, εμφανίζεται η προεπιλεγμένη οθόνη του Blender (Ει-
κόνα 10.15), που αποτελείται από 5 βασικές περιοχές. 

 
 Το παράθυρο Info βρίσκεται στην κορυφή του παραθύρου (σημείο 1 της Εικόνας 10.15) και 

περιλαμβάνει: 
o τη γραμμή μενού της εφαρμογής,  
o αναδυόμενη λίστα για τη διάταξη της τρέχουσα οθόνης,  
o αναδυόμενη λίστα για επιλογή σκηνής,  
o αναδυόμενη λίστα για επιλογή μηχανής απόδοσης γραφικών (Rendering), 
o πληροφορίες για τους διαθέσιμους πόρους του συστήματος. 
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Εικόνα 10.14 Αρχική οθόνη στο Blender. 

 
 Το παράθυρο 3D προβολής, στο σημείο 2 της Εικόνας 10.15, όπου σχεδιάζονται τα τρισδιά-

στατα αντικείμενα. 
 

 Σο παράθυρο Outliner πάνω δεξιά (σημείο 3), όπου εμφανίζεται μία λίστα με όλα τα αντικεί-
μενα της σκηνής. 

 
 Το παράθυρο Properties στο κάτω δεξιό μέρος (σημείο 4) περιέχονται πλαίσια ρυθμίσεων και 

επιλογών για τα αντικείμενα. Μέσω αυτών των επιλογών ορίζονται οι περισσότερες από τις 
λειτουργίες που εκτελεί το Blender στα αντικείμενα και τα υλικά για το animation και το 
rendering. 

 
 Το παράθυρο Timeline στο σημείο 5 (γραμμής χρόνου) επιτρέπει την κίνηση στον άξονα του 

χρόνου και χρησιμοποιείται για τη δημιουργία κινουμένων σχεδίων. 
 

 
 
Εικόνα 10.15 Το περιβάλλον εργασίας του Blender. 
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10.2.2. Παράθυρο 3D προβολής  
 
Το παράθυρο 3D προβολής είναι το μεγαλύτερο από τα παράθυρα στην προεπιλεγμένη οθόνη και ουσιαστικά 
αποτελεί το κεντρικό σημείο του λογισμικού. Κάποια από τα εργαλεία που συναντάμε στο παράθυρο είναι: 

 
To 3D Transform Manipulator, ένα οπτικό βοήθημα για τον μετασχηματισμό αντικειμένων 
(grab/move, rotate και scale).  

Η ρύθμισή του πραγματοποιείται από τα τέσσερα εικονίδια . 
  

O 3D Cursor, που έχει διάφορες λειτουργίες, όπως να σηματοδοτεί το σημείο όπου τα νέα αντικεί-
μενα θα εμφανίζονται, όταν δημιουργηθούν για πρώτη φορά, ή να σηματοδοτεί το κέντρο της πε-
ριστροφής.  
 

 

To Cube Mesh είναι ένας απλός κύβος που βρίσκεται στο κέντρο του 3D χώρου και χρησιμοποιεί-
ται ως υπόδειγμα σε κάθε νέο έργο.  
  

Το Lamp, το οποίο αντιπροσωπεύει τη θέση και το είδος της πηγής φωτός, η οποία είναι τοποθε-
τημένη κάπου κοντά στο κέντρο του 3D χώρου.  
 

 

Η Camera, η οποία χρησιμοποιείται για να ορίσει την οπτική γωνία (θέση) για μετατροπή των 
τριών διαστάσεων σε δυο κατά το rendering.  
 

 
 

Πίνακας 10.1 Εργαλεία του παραθύρου 3D προβολής. 

 

10.2.3. Περιήγηση στον τρισδιάστατο χώρο 
 
Μια βασική δυσκολία που αντιμετωπίζουμε, όταν εργαζόμαστε με το Βlender (ή οποιοδήποτε άλλη εφαρμογή 
για γραφικά 3D) είναι πώς θα αποδοθούν οι τρεις διαστάσεις στην οθόνη. Δηλαδή, πώς θα αποδοθούν οι τρεις 
διαστάσεις στην οθόνη των δύο διαστάσεων. Άρα, πρέπει να δούμε, πώς μπορούμε αρχικά να αλλάξουμε την 
οπτική γωνία στην 3D σκηνή του Βlender.  

Η οπτική γωνία ορίζεται από 3 παραμέτρους: 
 τη θέση μέσα στον 3D χώρο, 
 την κατεύθυνση προς την οποία κοιτάζουμε, 
 τον συντελεστή μεγέθυνσης (zoom). 

Αλλαγή της οπτικής γωνίας σημαίνει τροποποίηση μίας ή περισσότερων από αυτές τις παραμέτρους. 
 

 
 
Εικόνα 10.16 Αλλαγή οπτικής γωνίας θέασης. 
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Όταν ανοίξουμε τα εργαλεία θα παρουσιαστεί η αρχική οθόνη, όπως παρουσιάζεται στην Εικόνα 

10.15. Τοποθετώντας τον δείκτη του ποντικιού στο παράθυρο 3D προβολής μπορούμε: 
 να αλλάξουμε τη θέση από την οποία βλέπουμε τη σκηνή (π.χ. Εικόνα 10.16), κινούμενοι σε 

τροχιά γύρω από αυτήν με έναν από τους ακόλουθους τρόπους:  
o κρατώντας πατημένο το μεσαίο κουμπί του ποντικιού και μετακινώντας το ελεύθερα, 
o χρησιμοποιώντας τα πλήκτρα 2, 4, 6 και 8 από το αριθμητικό πληκτρολόγιο. 

 
 να πλησιάσουμε ή να απομακρυνθούμε από το κέντρο της σκηνής (zoom in / zoom out): 

o με τη ροδέλα στο ποντίκι, ή 
o με το μεσαίο κουμπί του ποντικιού με ταυτόχρονα πιεσμένο το πλήκτρο CTRL, ή 
o με τα πλήκτρα + και – από το αριθμητικό πληκτρολόγιο. 

 
Το Blender διαθέτει ένα σύνολο από συγκεκριμένες προβολές, οι οποίες είναι διαθέσιμες ή από το 

μενού View στη γραμμή τίτλου του παραθύρου, στο κάτω μέρος του παραθύρου, είτε από το αριθμητικό 
πληκτρολόγιο: 

 Προβολή από πάνω: 7 
 Προβολή από κάτω: CTRL + 7 
 Προβολή από την μπροστά πλευρά: 1 
 Προβολή από την πίσω πλευρά: CTRL + 1 
 Προβολή από δεξιά: 3 (π.χ. Εικόνα 10.17) 
 Προβολή από αριστερά: CTRL + 3 

 

 
 
Εικόνα 10.17 Αλλαγή οπτικής γωνίας θέασης. 

 
Πολύ χρήσιμη είναι η προβολή της σκηνής από την οπτική γωνία της κάμερας. Αυτή είναι, επίσης, 

διαθέσιμη από το μενού View στη γραμμή τίτλου του παραθύρου, αλλά και πατώντας το πλήκτρο 0 από το 
αριθμητικό πληκτρολόγιο (Εικόνα 10.18). 

 

10.2.4. Αποθήκευση και εξαγωγή 
 
Η αποθήκευση στο Blender γίνεται από το μενού με την εντολή «File > Save». Στο παράθυρο που εμφανίζε-
ται δηλώνουμε το όνομα για το νέο αρχείο και τον φάκελο αποθήκευσης. Το Blender έχει τη δυνατότητα να 
χρησιμοποιεί διαφορετική κατάληξη αρχείου σε κάθε αποθήκευση (π.χ. .blend1, .blend2, .blend3). Για παρά-
δειγμα, αν υπάρχει ένα αρχείο με όνομα Class3D.blend και προσπαθήσουμε να αποθηκεύσουμε με το ίδιο 
όνομα, τότε αυτόματα το προηγούμενο αρχείο θα μετονομαστεί σε Class3D.blend1. Με αυτόν τον τρόπο δια-
τηρούνται παλαιότερες εκδόσεις αρχείων, τα οποία μπορούμε να χρησιμοποιήσουμε, προκειμένου να αναιρέ-
σουμε αλλαγές. 
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Εικόνα 10.18 Προβολή οπτικής γωνίας κάμερας. 

 
Για την εξαγωγή μιας εργασίας χρησιμοποιούμε την επιλογή «File > Export» και στη συνέχεια επι-

λέγουμε τη μορφή αρχείου (Εικόνα 10.19).  
 

 
 
Εικόνα 10.19 Εξαγωγή σε άλλες μορφές. 

 
Μία από τις σημαντικότερες λειτουργίες της εφαρμογής είναι η δημιουργία και εξαγωγή της εργασίας 

ως εικόνα ή βίντεο, δηλαδή η εφαρμογή rendering. Για τον σκοπό αυτό μπορεί να χρησιμοποιηθεί είτε η οπτι-
κή γωνία του παραθύρου 3D προβολής είτε η οπτική γωνία της κάμερας. 

Για να δημιουργηθεί μία εικόνα (ή ένα βίντεο) από την οπτική γωνία του χρήστη (δηλαδή ότι βλέπει 

μέσα από το παράθυρο 3D προβολής), χρησιμοποιούνται τα εικονίδια , τα οποία βρίσκονται κάτω από 
το παράθυρο 3D προβολής. Το αποτέλεσμα για ένα απλό σχέδιο εμφανίζεται στην Εικόνα 10.20. 

 

 
 
Εικόνα 10.20 Rendering εικόνας από την οπτική γωνία του χρήστη. 

 
Για να δημιουργηθεί η εικόνα ή το βίντεο από την οπτική γωνία της κάμερας χρησιμοποιούνται τα ει-

κονίδια , τα οποία βρίσκονται στο παράθυρο 
Properties. Το αποτέλεσμα για ένα απλό σχέδιο εμφανίζεται στην Εικόνα 10.21. 
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Και στις δύο περιπτώσεις η παραγόμενη εικόνα εμφανίζεται σε νέο παράθυρο. Κάτω από το παράθυ-
ρο 3D προβολής, υπάρχει το μενού «Image > Save as Image», από όπου μπορούμε να αποθηκεύσουμε τη 
σκηνή ως μια εικόνα. 

 

 
 

Εικόνα 10.21 Rendering εικόνας από την οπτική γωνία της κάμερας. 
 

 
 

Εικόνα 10.22 Ρυθμίσεις βίντεο στο παράθυρο Properties. 

 

 
 

Εικόνα 10.23 Προκαθορισμένες ρυθμίσεις βίντεο. 

 

 
 

Εικόνα 10.24 Επιλογές φακέλου και μορφότυπου αποθήκευσης. 

 
Αν επιλέξουμε να παράγουμε βίντεο, τότε αρχίζει η διαδικασία δημιουργίας του βίντεο με βάση τις 

ρυθμίσεις, για τις οποίες έχουμε ορίσει αντίστοιχο πεδίο του παράθυρου Properties. Για παράδειγμα, στην 
Εικόνα 10.22, βλέπουμε τις διαστάσεις και το frame rate (fps) που έχουν οριστεί. Στην Εικόνα 10.23 εμφανί-
ζονται οι επιλογές της αναδυόμενης λίστα «Render Presets». Οι προεπιλογές αυτές αφορούν τις ρυθμίσεις του 
παραγόμενου βίντεο, π.χ. HDTV 1080p. Στο κάτω μέρος του παράθυρου Properties υπάρχει η κάρτα 
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«Output», όπου μπορούμε να ορίσουμε τον φάκελο αποθήκευσης του βίντεο και τη μορφή εξόδου του βίντεο 
(Εικόνα 10.24). 

 

10.2.5. Εισαγωγή, επιλογή, διαγραφή αντικειμένου 
 
Για την εισαγωγή νέου αντικειμένου στον χώρο δημιουργίας των γραφικών, πρέπει να επιλέξουμε από τη 
γραμμή μενού της εφαρμογής, στο κάτω μέρος της οθόνης, την επιλογή «Add > Mesh». Εμφανίζεται το με-
νού της Εικόνας 10.25, όπου μπορούμε να επιλέξουμε το κατάλληλο σχήμα. Όπως αναφέραμε στο Κεφάλαιο 
4, τα σχήματα αυτά είναι βασικά (primitive) και αποτελούνται από ένα πλέγμα πολυγώνων (mesh). Υπάρχουν 
ως αυτόνομα σχήματα στα εργαλεία σχεδίασης τρισδιάστατων γραφικών. 
 

 
 

Εικόνα 10.25 Βασικά σχήματα. 
 
Κάνοντας κλικ στο όνομα ενός σχήματος, π.χ. «UV Sphere», δημιουργείται το αντίστοιχο αντικείμενο 

στο κέντρο της σκηνής (π.χ. Εικόνα 10.26).  
Η επιλογή ενός σχήματος γίνεται με δεξί κλικ πάνω σε κάποιο αντικείμενο. Το επιλεγμένο αντικείμε-

νο έχει πορτοκαλί περίγραμμα, όπως βλέπουμε στην Εικόνα 10.26. Με κλικ στο πλήκτρο DEL του πληκτρο-
λογίου μπορούμε να διαγράψουμε ένα αντικείμενο. 

 

 
 

Εικόνα 10.26 Σχήματα που έχουν προστεθεί στη σκηνή. 

 

10.2.6. Μετακίνηση, περιστροφή, μεταβολή μεγέθους αντικειμένου 
 
Όταν επιλέγουμε ένα αντικείμενο στον 3D χώρο, εμφανίζονται οι οπτικοί χειριστές, όπως φαίνονται στην Ει-
κόνα 10.27.  

Ένας από τους γρηγορότερους τρόπους για τη διαχείριση του επιλεγμένου αντικειμένου είναι μέσω 
του πληκτρολογίου. Πιέζοντας κάθε ένα από τα πλήκτρα G, R και S, ενεργοποιούνται, αντίστοιχα, οι κατα-
στάσεις μετακίνησης (grab), περιστροφής (rotate) και μεταβολής μεγέθους (scale), για το επιλεγμένο αντι-
κείμενο. Έπειτα σύρουμε το ποντίκι και αυξάνει το μέγεθος ή μετακινείται ή περιστρέφεται το αντικείμενο, 
ανάλογα με το επιλεγμένο αντικείμενο. Αν, σύροντας το ποντίκι, κρατήσουμε το μεσαίο κουμπί του ποντικιού 
πατημένο, η αλλαγή συμβαίνει μόνο κατά μήκος ενός άξονα. Παραδείγματος χάριν, στην Εικόνα 10.28 βλέ-
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πουμε ένα σχήμα που δημιουργήθηκε από έναν κύβο. Πατήσαμε το πλήκτρο S και έπειτα με πιεσμένο το με-
σαίο πλήκτρο του ποντικιού σύραμε προς τα εμπρός, δηλαδή στον άξονα Χ. 
 

 
 

Εικόνα 10.27 Χειριστές σε ένα σχήμα. 

 
Εκτός από τα πλήκτρο G, R και S μπορούμε να χρησιμοποιήσουμε τα εικονίδια 3D Transform 

Manipulator  . Τα εικονίδια έχουν την ίδια συμπεριφορά, όπως τα πλήκτρα G, R, και S.  
Για να οριστικοποιηθεί η επιθυμητή μεταβολή πρέπει να κάνουμε αριστερό κλικ ή να πιέσουμε το 

πλήκτρο Enter. Για να ακυρωθεί μια μεταβολή πρέπει να γίνει δεξί κλικ ή να πιέσουμε το Esc. 
Μπορούμε, επίσης, να μετακινήσουμε το αντικείμενο μέσα στον χώρο απλά με κλικ στο αντικείμενο 

και κρατώντας πατημένο το αριστερό πλήκτρο του ποντικιού. 
Με κλικ στην άκρη ενός βέλους από τα τρία βέλη, μπορούμε να το μετακινήσουμε κατά μήκος αυτού 

του άξονα. Σύροντας το ποντίκι κατά μήκος του επιλεγμένου άξονα, μετακινείται και το ποντίκι. Στην Εικόνα 
10.29 έχουμε επιλέξει τον άξονα Χ (κόκκινο βέλος), οπότε το αντικείμενο μετακινείται κατά μήκος του άξο-
να. 

 

 
 

Εικόνα 10.28 Μεταβολή μεγέθους σε έναν άξονα. 

 
 

 
 

Εικόνα 10.29 Μετακίνηση στον άξονα X. 
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10.2.7. Μετασχηματισμοί αντικειμένων 
 
Στο προηγούμενο θέμα είδαμε αλλαγές που επηρεάζουν όλο το αντικείμενο. Αν θέλουμε να μεταβάλουμε 
κορυφές ή ακμές ή προσόψεις, τότε χρειάζεται να αλλάξουμε αρχικά την κατάσταση λειτουργίας. Στο κάτω 
μέρος της οθόνης πρέπει να επιλέξουμε «Edit Mode» στην αναδυόμενη λίστα «Object Mode» (Εικόνα 
10.30). 

Στο κάτω μέρος της οθόνης εμφανίζονται τα εικονίδια , μέσω των οποίων μπορούμε να επι-
λέξουμε, αν θα επεξεργαστούμε τις κορυφές (vertex) ή τις ακμές (edge) ή τις προσόψεις (faces).  

Η επιλογή (κορυφής, ακμής ή πρόσοψης) γίνεται με δεξί κλικ. Στην Εικόνα 10.31 εμφανίζεται ένας 
κύβος, όπου έχουν επιλεχθεί κάποιες κορυφές του. Στη συνέχεια, με χρήση του πλήκτρου G ή του αντίστοι-
χου πλήκτρου από τα εικονίδια 3D Transform Manipulator, έχει μετασχηματιστεί. 

 

 
 

Εικόνα 10.30 Αλλαγή κατάστασης επεξεργασίας αντικειμένων. 

 

 
 

Εικόνα 10.31 Αλλαγή κατάστασης επεξεργασίας αντικειμένων. 
 

10.2.8. Υλικό και υφή αντικειμένων 
 
Το υλικό (material) καθορίζει τα βασικά οπτικά χαρακτηριστικά ενός αντικειμένου, δηλαδή το χρώμα του και 
το πόσο θαμπό ή γυαλιστερό είναι. Η υφή (texture) μπορεί είτε να αναδεικνύει το υλικό κατασκευής κάποιου 
αντικειμένου, π.χ. τούβλα ή ξύλο, είτε να είναι κάποια υφή παραγόμενη από υπολογιστή. Βασικός στόχος της 
υφής είναι το αντικείμενο να δείχνει πιο φυσικό. Στο Blender η υφή εφαρμόζεται στο υλικό και έτσι ο καθο-
ρισμός του υλικού προηγείται του καθορισμού της υφής.  

Αρχικά πρέπει να εντοπίσουμε το εικονίδιο «Material»  στο παράθυρο 
Properties στη δεξιά πλευρά του Blender. Έπειτα πρέπει να κάνουμε κλικ στο κουμπί «New», ώστε να προ-
σθέσουμε ένα νέο υλικό (Εικόνα 10.32). Εμφανίζεται η Εικόνα 10.33, όπου εμφανίζεται το νέο υλικό και κά-
ποιες ρυθμίσεις. 

 

 
 

Εικόνα 10.32 Προσθήκη νέου υλικού. 

 
Οι σημαντικότερες ρυθμίσεις, οι οποίες σχετίζονται με το νέο υλικό, είναι: 

 Diffuse: το βασικό χρώμα του υλικού. 
 Specular: το πόσο γυαλιστερό ή θαμπό είναι. 
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 Mirror: οι ανακλαστικές ιδιότητες του υλικού. 
 Shading: σκίαση. 
 Transparency: διαφάνεια. 

 
Μπορούμε να πειραματιστούμε με τις επιλογές, ώστε να επιτύχουμε τον επιθυμητό χρωματισμό και 

γενικά το αισθητικό αποτέλεσμα που θέλουμε. Στην Εικόνα 10.34 έχει γίνει rendered ενός αντικειμένου από 
την οπτική του χρήστη. Στη δεξιά πλευρά φαίνονται κάποιες από τις ρυθμίσεις που εφαρμόστηκαν. 
 

 
 

Εικόνα 10.33 Ιδιότητες νέου υλικού. 

 

 
 

Εικόνα 10.34 Αντικείμενο που έχει γίνει rendered. 
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Η υφή προστίθεται το εικονίδιο «Texture»  στο παράθυρο Proper-
ties στη δεξιά πλευρά του Blender. Κάτω από το παράθυρο κάνουμε κλικ στο «New» και επιλέγουμε κάποια 
από τις προκαθορισμένες υφές στο πλαίσιο «Type». Για παράδειγμα, στην Εικόνα 10.35 εμφανίζεται κάποια 
από τις προκαθορισμένες υφές και το αποτέλεσμα εμφανίζεται στην Εικόνα 10.36. Στο κάτω μέρος του παρα-
θύρου των ρυθμίσεων των υφών μπορούμε να πειραματιστούμε με τα χρώματα. 

Στο πλαίσιο «Type» μπορούμε να επιλέξουμε «Image or Movie» και να εισάγουμε ένα δικό μας αρ-
χείο, το οποίο θα χρησιμοποιηθεί ως υφή. Στην Εικόνα 10.37 βλέπουμε ότι έχει επιλεγεί μια υφή μορφής ξύ-
λου και στην Εικόνα 10.38 φαίνεται το αποτέλεσμα της εφαρμογής της υφής. 

 
 

 
 

Εικόνα 10.35 Επιλογή κάποιας από τις προκαθορισμένες υφές. 

 
 

 
 

Εικόνα 10.36 Αντικείμενο που έχει γίνει rendered με την προκαθορισμένη υφή της προηγούμενης εικόνας. 

 
 

 
 

Εικόνα 10.37 Προσθήκη εικόνας ως υφής. 
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Εικόνα 10.38 Αντικείμενο που έχει γίνει rendered με την υφή της προηγούμενης εικόνας. 

 

10.2.9. Animation ενός αντικειμένου 
 
Το animation ενός αντικειμένου στο Blender μπορεί να γίνει με τη διαδοχική προβολή καρέ, τα οποία δίνουν 
την αίσθηση της κίνησης, όπως έχουμε εξηγήσει στο Κεφάλαιο 4. Πρακτικά χρειάζεται να ορίσουμε τα 
keyframes που καθορίζουν την κίνηση του αντικειμένου. Για την εξαγωγή της σχεδιοκίνησης σε βίντεο, πρέ-
πει να ορίσουμε το Frame Rate. Συνήθως, ορίζεται στα 24 fps. Υπάρχουν διάφοροι τρόποι κίνησης ενός αντι-
κειμένου. Ο πιο απλός τρόπος είναι με τη μετακίνηση του αντικειμένου σε κάποια σημεία και την καταγραφή 
των βασικών keyframes.  

Έστω ότι θέλουμε να δημιουργήσουμε ένα animation ενός κύβου στον χώρο. Ορίζουμε στο παράθυρο 

Properties, στη δεξιά πλευρά του εργαλείου, το frame rate 24 fps . Στο κάτω μέρος ορίζουμε 48 

καρέ με ορισμό του End στο 48 . Συνεπώς, ορίσαμε ένα animation 2 δευτερο-
λέπτων. 

Στη συνέχεια πρέπει να ορίσουμε τα keyframes. Έστω ότι θέλουμε να ορίσουμε τη θέση του αντικει-

μένου στα frames 1, 15, 35 και 48. Πιέζουμε το εικονίδιο , ώστε να καταγραφούν από το λογισμικό τα 
keyframes που θα ορίσουμε. Μετακινούμε το αντικείμενο, με χρήση δεξί κλικ και σύρσιμο στη θέση που θέ-
λουμε να βρίσκεται στο καρέ 1. Στο κάτω μέρος, δίπλα από τα πλαίσια Start και End, ορίζουμε τον αριθμό 

. Στη συνέχεια μετακινούμε το αντικείμενο σε μια νέα θέση και ορίζουμε ως αριθμό καρέ το 15 
στο αντίστοιχο πλαίσιο. Επαναλαμβάνουμε και τη θέση στα υπόλοιπα καρέ και το animation είναι έτοιμο. Με 

χρήση των χειριστηρίων  μπορούμε να δούμε το animation. Στην παραπάνω ενότητα 2.4 αυ-
τού του κεφαλαίου είδαμε πώς μπορεί να εξαχθεί το animation ως αρχείο βίντεο.  

Στις ιστοσελίδες https://en.wikibooks.org/wiki/Blender_3D:_Noob_to_Pro/Basic_Animation και 
http://www.raywenderlich.com/52804/beginning-blender-tutorial-animating-rendering-mushroom μπορείτε να 
βρείτε και άλλα παραδείγματα animation στο Blender. 

 

10.3. Ανακεφαλαίωση – βασικές έννοιες 
 
Στο τρέχον κεφάλαιο έγινε επισκόπηση των βασικών δυνατοτήτων των εργαλείων επεξεργασίας γραφικών 3Δ  
και animation 3ds Max και του δωρεάν εργαλείου Blender. Και τα δύο εργαλεία έχουν πάρα πολλές δυνατό-
τητες και έχουν χρησιμοποιηθεί ακόμη και στη δημιουργία ταινιών. Η παρουσίαση ενός μεγαλύτερου συνό-
λου των δυνατοτήτων τους θα απαιτούσε πολλά κεφάλαια ή ακόμη και ένα βιβλίο, καθώς κάθε ενέργεια είναι 
συνήθως πολύπλοκη και απαιτεί πολλαπλά βήματα. Το 3ds Max είναι πιο ώριμο εργαλείο και κάποιες από τις 
επιλογές του εφαρμόζονται με πιο εύκολο τρόπο σε σχέση με το Blender. Ωστόσο, πρέπει να έχουμε υπόψη 
μας ότι το Blender είναι, επίσης, αρκετά ισχυρό εργαλείο και διατίθεται δωρεάν. Η βιβλιογραφία είναι πιο 
φτωχή στην περίπτωση του Blender, αν και τελευταία έχουν εμφανιστεί βιβλία που εξηγούν ακόμη και τον 
τρόπο δημιουργίας παιχνιδιών με το συγκεκριμένο εργαλείο. 
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